


COMPUTER APPLICATION-1

1. My New Friend

 Let Us Answer 

A. Fill in the blanks with the suitable words given below :
1. friend, 2. things, 3. laptop, 4. features.

B. Write T for True and F for False for the following statements :
1. F, 2. F, 3. T, 4. T.

2. Computer Is A Machine

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Television, 2. (c) orders, 3. (a) Bicycle, 4. (b) smart, 5. (a) True.

B. Fill in the blanks with the suitable words given below :
1. machine, 2. smart, 3. human, 4. time, 5. car.

C. Write T for True and F for False for the following statements :
1. T, 2. T, 3. F, 4. T, 5. F.

D. Which of the following images are machines? Encircle them with
Green colour :
Do it yourself.

E. Who am I?
1. Computer, 2. Machine, 3. Juicer, 4. Bicycle, 5. Car.

F. Answer the following questions :
1. A machine is a man-made thing which helps us to do different types of 

work.
2. Petrol and diesel.
3. A computer is an electronic device or machine.
4. The two features of a machine are :

 (i) Machines are man-made things.
(ii) Machines work fast.

5. The two features of a computer are :
 (i) It runs on electricity.
(ii) It can do many things which make our work easier.

3. Uses Of A Computer

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Both of these, 2. (a) Movies, 3. (c) Both of these, 4. (a) Tickets,
5. (b) Teach.
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B. Fill in the blanks with the suitable words given below :
1. wonderful, 2. things, 3. calculations, 4. draw, 5. search.

C. Write T for True and F for False for the following statements :
1. T, 2. F, 3. T, 4. F, 5. T.

D. Rearrange the words and find out the places where computers are
used. Write them with Blue colour :
1. BANKS, 2. OFFICE, 3. HOME, 4. SHOPS, 5. SCHOOLS.

E. Short Answer Type Questions :
1. Yes, we can hear music on a computer.
2. Computer is used at railway station for booking tickets.
3. Yes, computer can be used for learning and teaching in school.
4. Yes, computer is useful in chatting with friends.

F. Long Answer Type Questions :
1. The two ways in which computer can help people are :
(i) We can play games on it.
(ii) We can watch movies, videos and cartoons on it.
2. Three places where computers are, used are school, hotel and at airport.
3. A person can book a ticket are, airport and railway station.
4. Computer is used for money transactions in banks.

4. Parts Of A Computer

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) CPU, 2. (c) Monitor, 3. (a) Mouse, 4. (b) Printer, 5. (b) Keyboard.

B. Fill in the blanks with the suitable words given below :
1. parts, 2. CPU, 3. point, 4. keys, 5.  television.

C. Write T for True and F for False for the following statements :
1. T, 2. F, 3. F, 4. T, 5. T.

D. Rearrange the words to find the names of the parts of a computer :
1. MONITOR, 2. PRINTER, 3. MOUSE, 4. KEYBOARD.

E. Short Answer Type Questions :
1. Mouse, 2. Monitor, 3. Keyboard, 4. Mouse, 5. Printer.

F. Long Answer Type Questions :
1. The full form of CPU is Central Control Processing Unit.
2. We can watch movies and cartoons on a monitor.
3. There are two buttons and a scroll wheel on a mouse.
4. Printer is used to give printout.
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5. The Keyboard

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Chalk, 2. (b) 104, 3. (a) Space Bar, 4. (b) Prnt Scrn,
5. (b) Number keys.

B. Fill in the blanks with the suitable words given below :
1. Keys, 2. Spacebar, 3. End, 4. Twelve, 5. Cal cu la tor.

C. Write T for True and F for False for the following statements :
1. T, 2. T, 3. F, 4. T, 5. F.

D. Look at these keys and match them with their names :

E. Short Answer Type Questions :
1. Four keys.         2. Spacebar key.
3. Page Down key.        4. Tab key.
5. Windows Logo key.

F. Long Answer Type Questions :
1. Purpose of Prnt Scrn key is to take a print shot of a computer screen.
2. Caps lock key helps to type letters in capital until it is deactivated.
3. Spacebar key is used to add spaces between two words.
4. Alphabet keys help us to type letters, words, sentences and long

paragraphs on a page.
5. Help key moves the cursor to the beginning of a line in a document.

6. Working With Mouse

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Mouse, 2. (b) Two, 3. (a) Index, 4. (c) Once, 5. (c) Dragging.

B. Fill in the blanks with the suitable words given below :
1. big, 2. middle, 3. drawing, 4. arrow, 5. twice.
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C. Write T for True and F for False for the following statements :
1. F, 2. F, 3. T, 4. T, 5. F.

D. Match the following devices with their names :

E. Short Answer Type Questions :
1. Two, 2. Mouse, 3. CPU, 4. Yes, 5. Left button and right button.

F. Long Answer Type Questions :
1. The uses of a mouse are:

 (i) A mouse is used to select or deselect anything.
(ii) A mouse is used to create drawings.

(iii) A mouse is used to play games.
(iv) A mouse is used to fill colours.
(v) A mouse is used to move an object.

(vi) A mouse is used to click or double click anything.
2. The right way to hold a mouse are :

(i) Place your index finger on the left mouse button.
(ii) Place your middle finger on the right mouse button.

(iii) Remaining fingers are used to hold the mouse.
(iv) Place your palm on the mouse.
(v) You can use the scroller with the index finger.

(vi) Now, you can move your mouse easily with your hand.
3. An object can be selected as follows :

(i) Hold the mouse with your hand.
(ii) Click the This PC icon once.

(iii) It will get highlighted. It means it is selected.
4. Double clicking means to press the left mouse button twice rapidly. It

is used to open an application or folder.
5. Right click shows a list of commands on the monitor.
6. For this, first place the pointer over an item on the screen. Now press

hold down the left mouse button and keeping it pressed, drag the
mouse (pointer) to the place where you want to place the item. You
will notice that the object moves along and drop the object by
releasing the button.
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7. Introduction To MS Paint

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) MS Paint, 2. (a) Oval, 3. (b) Eraser, 4. (c) Line.

B. Fill in the blanks with the suitable words given below :
1. Fill with Colour, 2. left, 3. Line, 4. Shapes.

C. Write T for True and F for False for the following statements :
1. T, 2. F, 3. T, 4. T, 5. T.

D. Match these figures with correct tool :

E. Short Answer Type Questions :
1. Pencil tool, 2. Oval tool.

F. Long Answer Type Questions :
1. MS Paint is a software that helps us to draw and paint on a computer.
2. The ways to draw a triangle using Paint are as follows :

(i) Go to Home tab.
(ii) Select drop-down arrow of Shapes com mand un der Shapes

group.
(iii) From the Shapes box, se lect Tri an gle tool.
(iv) Select red colour from the Colours group.
(v) When you move the mouse pointer to the drawing area, the pointer 

changes to + shape.
(vi) Now, click and drag the mouse to draw the shape.

3. The components of a Paint window are Paint button, Quick Access
Toolbar, Tab, Title bar, Ribbon, File menu, Groups, Scroll bar, Zoom
slider.

4. To select the size of the line, click on the size drop-down arrow and
select the size of the line.

COMPUTER APPLICATION-2

1. Fundamentals Of Computers

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) fast, 2. (b) accurate, 3. (b) big, 4. (a) Laptop, 5. (a) Tablet.
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B. Fill in the blanks using given hints :
1. electronic, 2. animations, 3. commands, 4. I.Q., 5. library.

C. Write T for True and F for False statements :
1. F, 2. T, 3. T, 4. T, 5. F.

D. Look at the pictures below and match to the corresponding task :

E. Short Answer Type Questions :
1. Man, 2. No, 3. No.

F. Long Answer Type Questions :
1. Two features of a computer are :

(i) A computer always produces accurate results.
(ii) A computer has large storage capacity and can store large.

2. The two uses of computer in school are :
(i) To keep records of the students and teaching and non-teaching staff.

(ii) To keep records of books in the library.
3. The two uses of computer in hospital are :

(i) To keep records of the doctors, their availability timings.
(ii) To keep records of the patients, their diseases and medicines.

4. Desktop and Laptop.

2. Parts Of Computer

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Speakers, 2. (b) mouse pad, 3. (b) 104, 4. (a) brain,
5. (b) Compact disk.

B. Fill in the blanks using given hints :
1. two, 2. hardcopy, 3. flash, 4. keys, 5. monitor.

C. Write T for True and F for False statements :
1. F, 2. T, 3. F, 4. F, 5. T.
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D. Short Answer Type Questions :
1. Softcopy, 2. Keys, 3. 104, 4. Mouse, 5. Pen drive.

E. Long Answer Type Questions :
1. The four main parts of a computer are monitor, keyboard, mouse and

CPU.
2. CPU is used to process the data.
3. The various keys on the keyboard are, alphabetic, numeric, functions,

spacebar, delete, backspace, tab, arrow keys and special keys.
4. Various types of mouse are, button mouse, scroll mouse, ball mouse

and optical mouse.
5. The functions performed by using mouse are, single click, double

click, drag and drop and right click.

3. Working Of Computer

 Let Us Answer 

A. Multiple Choice Questions :
1. (b) program, 2. (a) input, 3. (b) information, 4. (a) work, 5. (c) display.

B. Fill in the blanks using given hints :
1. Printer, 2. CPU, 3. enter, 4. Programs, 5. Mouse.

C. Write T for True and F for False statements :
1. F, 2. T, 3. F, 4. F, 5. T.

D. Short Answer Type Questions :
1. Processing device, 2. Information, 3. CPU, 4. Central Processing Unit.

E. Long Answer Type Questions :
1. Three steps involved in the working of a computer are Input, Process

and Output.
2. (i) Data are raw facts and figures which have no meaning whereas

information is the processed data.
3.  (i) Input Devices : Keyboard, Mouse.

(ii) Output Devices : Monitor, Printer.
4.  (i) Input : Input means to enter the data into the computer.

(ii) Processing : Processing means to work on the data.
(iii) Output : Output means to display the data.

4. Operating A Computer

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) power button, 2. (c) Shut down or sign out, 3. (a) Uninterruptable,
4. (b) Power button.

B. Fill in the blanks using given hints :
1. UPS, 2. monitor, 3. shutdown, 4. power button.
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C. Write T for True and F for False statements :
1. F, 2. T, 3. T, 4. F.

D. Arrange the steps in sequence to switch on the computer :
Step 1 Switch ON power button
Step 2 Switch ON the UPS
Step 3 Switch ON the CPU
Step 4 Switch ON the monitor

E. Short Answer Type Questions :
1. UPS, 2. Shutdown or Signout, 3. Uninterruptable Power Supply.

F. Long Answers Type Questions :
1. The steps to switch on the computer are :

Step 1. Switch ON the main power supply.
Step 2. Switch ON the UPS button.
Step 3. Switch ON the CPU.
Step 4. Switch ON the monitor.

2. To shutdown the computer, follow the given steps :
Step 1 : Go to Start> Shutdown or Signout.
Step 2 : Now click on the Shutdown button.
Step 3 : Now wait for some time till the computer shuts down
completely.
Step 4 : Switch OFF the monitor.
Step 5 : Switch OFF UPS.
Step 6 : Switch OFF main power supply.

5. MS Windows

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Windows 10, 2. (a) bottom, 3. (a) computer, 4. (a) size, 5. (c) arrow.

B. Fill in the blanks using given hints :
1. document, 2. Icon, 3. white, 4. Operating system, 5. bottom.

C. Match the following images to their task :
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D. Short Answer Type Questions :
1. Windows 10, 2. Taskbar, 3. Icon, 4. Title bar.

E. Long Answer Type Questions :
1. The operating system is a special set of instructions which manages

all the jobs of computer and makes it run.
2. The first screen that appears on starting the computer is called the

Desktop Screen.
3. (a) Icon is a small picture which represents a particular program.

(b) Shortcut is an icon with arrow.

6. Keyboard

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Keyboard, 2. (b) 26, 3. (c) 104, 4. (a) Shift, 5. (c) Spacebar.

B. Fill in the blanks using given hints :
1. twelve, 2. Enter, 3. four, 4. Numeric, 5. Caps Lock.

C. Write T for True and F for False statements :
1. F, 2. F, 3. T, 4. T, 5. F.

D. Match the keys to given words :

E. Short Answer Type Questions :
1. Input device, 2. 104 keys, 3. Twelve, 4. Top of the keyboard, 5. Caps
Lock key.

F. Long Answer Type Questions :
1. A keyboard is used to enter data into the computer.
2. Alphabetic keys are the keys which contain alphabets or letters from

A to Z.
3. Numeric keys are the keys which contain numbers from 0 to 9. These

keys can be found at two places on the keyboard :
 (i)  One set is above the Alphabetic keys.
(ii)  The other set on the right side in the form of Numeric pad.
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4. There are four arrow keys on the keyboard which are used to move the 
cursor on the screen. A cursor is a small blinking line from where you
can start typing. These keys are also called cursor control keys.

5. Delete key
Delete key is a key which is used to delete one character to the right at
a time. To remove multiple character, you need to press the key
multiple times.
Backspace Key
Backspace key is a key which is used to delete one character to the left 
at a time. To remove multiple characters, you need to press the key
multiple times.

7. MS Paint

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) top, 2. (a) left or right, 3. (b) S, 4. (c) Windows Accessories,
5. (b) Exit.

B. Fill in the blanks by choosing the right word from the bracket :
1. O, 2. N, 3. Title, 4. Drawing, 5. G/F.

C. Write T for True and F for False statements :
1. F, 2. T, 3. T, 4. T, 5. T.

D. Match the options with corresponding tasks :
SAVE To open an existing file.
EXIT To save a new file.
NEW To save changes in an existing file.
OPEN To create a new file.
SAVE AS To close the Paint application.

E. Short Answers Type Questions :
1. MS Paint allows us to draw pictures and fill colours in them.
2. Drawing Area.
3. Oval.
4. Ctrl + S.
5. Ctrl + O.

F. Long Answers Type Questions :
1. The purpose of MS Paint is to use our imagination to draw and to

colour it using its tools.
2. A scroll bar is a long thin section at the edge of a monitor by which

material can be scrolled using a mouse. There are two scroll
bars—Horizontal and Vertical.
(i) Horizontal Scroll Bar is used to scroll the screen from left or right.

(ii) Vertical Scroll Bar is used to scroll the screen from top or bottom.
3. Save As option is used to save a new file.
4. The various file formats are, png, jpeg, bmp and gif.
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8. Learn More About Paint

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Pencil, 2. (b) Magnifier, 3. (a) Eraser, 4. (c) Fill With Color,
5. (a) Magnifier.

B. Fill in the blanks using given hints :
1. Oval, 2. Paint, 3. Text, 4. Color 1, 5. Color 2.

C. Write T for True and F for False statements :
1. F, 2. F, 3. T, 4. T, 5. T.

D. Match the shape with correct images :

E. Short Answers Type Questions :
1. Rounded Rectangle Callout; Circular Callout.
2. Pencil tool.
3. Five-point star and six-point star.

F. Long Answers Type Questions :
1. Eraser tool is used to erase the drawing.
2. Text tool is used to add text in a drawing.
3. Three types of brushes used in Paint are, Air Brush, Oil Brush and

Crayon.

9. MS Word 2016

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Microsoft, 2. (b) Title bar, 3. (c) Ruler, 4. (b) Ctrl + S, 5. (b) F4.

B. Fill in the blanks using given hints :
1. Save, 2. Print, 3. Open, 4. Ribbon, 5. Cursor.

C. Short Answers Type Questions :
1. Word processor is used to type, edit, format and print the text.
2. Working area.
3. Exit.
4. Status bar.
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D. Long Answers Type Questions :
1. MS Word, a word processor developed by Microsoft, is used to type,

edit, format and print the text.
2. Two features of MS Word 2016 are as follows :

(i) We can type and format the text.
(ii) We can edit the text.

3. To create a new document, the steps are as follows :
(i) Click on File menu.

(ii) From the drop-down list, select the New option.
(iii) Click on Blank document.
(iv) A blank document opens on the screen named Document 1.

4. To enter text in a document, the steps are as follows :
(i) Create a new document.

(ii) When the document is opened, a cursor comes on the screen.
(iii) Start typing data from the keyboard.
(iv) Provide space between the words using Spacebar key.

COMPUTER APPLICATION-3

1. Computer And Its Working

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Keyboard, 2. (c) Mouse, 3. (b) CPU, 4. (a) Once, 5. (b) Printer.

B. Fill in the blanks by choosing correct word from the given bracket :
1. Airport, 2. Banks, 3. ALU, 4. Memory, 5. Computer.

C. Write T for True and F for False statements :
1. F, 2. T, 3. F, 4. T, 5. F.

D. What is the purpose of following devices? Match to the correct
answer :

E. Answer these questions :
1. A computer is a machine which is being used in almost all fields

nowadays. You can see them in hotels, restaurants, hospitals, clinics,
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schools, colleges, universities, airport, railway stations, bus stands,
banks, shops, shopping malls, offices, and so on. We can see a
computer in virtually every field today.

2. Data are the raw facts and figures which need to be processed. It has
no meaning to the user until it is processed. When the data is
processed, it becomes information. Information is meaningful and
useful for any organization because it helps in decision making. The
user inputs data in the computer for processing. The computer
processes it and produces the output. This output is called
Information.

3. The printer prints the information seen on the monitor on to a paper.
This information printed on the paper is called the printout. Some
printers can print only in black and white while others can print in any
colour.
Many types of printers are available in the market. For example, dot
matrix printer, inkjet printer and laser printer.

4. The two advantages of computer are :
(i) Accuracy : A computer always produces an accurate result. The

accuracy depends on the quality of input.
(ii) Speed : Computer is a very fast machine. It works very fast and

performs calculations in milliseconds or nanoseconds.
5. The two drawbacks of computer are :

(i) Power Failure : You cannot use computer in case of power
failure. But these days, you can use laptops or iPads which can be
charged. You can work on them for hours without need of
electricity.

(ii) No IQ : A computer lacks IQ. It works on the instructions given to
it by the user. If you give the wrong input, it produces the result
according to it.

2. Hardware And Software

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Physical, 2. (c) Storage, 3. (a) Random Access, 4. (a) Operating
System, 5. (b) DVD.

B. Fill in the blanks by choosing correct word from the given bracket :
1. audio, 2. non-volatile, 3. specific, 4. MS PowerPoint, 5. Windows
Movie Maker.

C. Write T for True and F for False statements :
1. T, 2. T, 3. T, 4. F, 5. T.
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D. Match the following devices with their names :

E. Answer the following questions :
1. Hardware and Software.
2. The physical parts of a computer which can be touched and seen are

called Hardware.
3. A set of instructions given to the computer to perform a given task is

called a computer program or software.
4. The devices used to enter data into the computer are called input

devices.
5. Light Pen and Joystick are examples of input devices.
6. Operating System is a system software which acts as an interface

between the computer user and computer hardware. It allows the user
to use the computer system and work on it.

7. The software that performs a specific type of work is called
application software. It is specially designed for a particular
application.
Two application software are MS Word and MS Excel.

8. Two secondary storage devices are as follows :
DVD : DVD or Dig i tal Ver sa tile Disk is a dig i tal op ti cal disk that can
store any kind of dig i tal data. It is a thin cir cu lar plate which is of the
same size as a CD but has a large stor age capacity.
Pen Drive : Pen Drive is a small and portable storage device. It has
large storage capacity. One just needs to plug in to the CPU to access
the data stored in it. There is no need of any special drive to read its
contents.

3. Introduction To Windows 10

 Let Us Answer 

A. Multiple Choice Questions :
1. (b) Application, 2. (a) Operating System, 3. (c) Desktop, 4. (a) Sorting,
5. (c) Text Select.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Recycle Bin, 2. Windows, 3. Screen Saver, 4. Taskbar, 5. Icons.
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C. Write T for True and F for False statements :
1. F, 2. F, 3. T, 4. F, 5. T.

D. Short Answers Type Questions :
1. A set of programs which are essential to perform a task on the

computer is called a software.
Software is of two types :
(i) Application Software : It is used to perform some specific task.

(ii) System Software : It is used to manage the tasks which are meant
for a system.

2. (i) A voice controlled assistant  Cortana is now available in Windows
10.

(ii) It has multiple desktop features which make it possible to run
another windows as if on another screen.
Selecting and deselecting on icon is done as follows :

3. (A) Selecting an icon
To select an icon, follow the given steps :
(i) Move the mouse pointer on the icon which you want to select.

(ii) Click the left mouse button.
(iii) You will notice that it gets highlighted.

(B) Deselecting an icon
To deselect an icon, follow the given steps :
(i) Move pointer on the blank area of desktop.

(ii) Click once.
(iii) You will see that the selected icon is in normal form now.

4. To change the icons size, follow the given steps :
(i) Take the mouse pointer to the blank area of the desktop.

(ii) Press right mouse button.
(iii) A pop-up list opens.
(iv) Hover the mouse over View option.
(v) A further list opens up on the screen.

(vi) Click on Large icons or Medium icons or Small icons.
(vii) Observe the changes.

E. Long Answers Type Questions :
1. Operating System is a type of system software which acts as an

interface between the computer user and computer hardware.
 For example : Windows 10.

2. If you look at the desktop, you will see an image on its background.
To change the desktop background, you need to follow the given
steps :
(i) Move the mouse pointer to the blank area of the desktop.

(ii) Click the right mouse button.
(iii) A pop-up list appears.
(iv) Click on Personalize option.
(v) The Personalization window opens.
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(vi) You can see that the Background option is selected by default and
you can preview the background image on the right side of the
window.

(vii) Click on the drop-down arrow of the Background list box.
(viii) A drop-down list opens, select Picture option.

(ix) From Choose your picture section, select a picture by clicking on it 
or click on Browse option to find more picture options.

(x) Click on drop-down arrow of Choose your fit list box, select any
option according to your choice (say Fit).

(xi) After making selections, you can preview the background picture
in Preview section.

(xii) The desktop background picture is changed with the selected one.
(xiii) Now close the Personalize window by clicking on Close button.

3. The small labelled pictures or symbols present on the desktop are
called icons. The icons which are always present on the desktop are :
(i) This PC

(ii) Network
(iii) Recycle Bin.

4. (a) Arrange the desktop icons :
(i) Move the mouse pointer on the blank area of the desktop.

(ii) Press right mouse button.
(iii) A pop-up list opens.
(iv) Hover the mouse over View option.
(v) A further list opens.

(vi) Click on Auto arrange icons option.
(vii) The icons on the desktop will be arranged automatically.

(b) Change the icons size :
 (i) Take the mouse pointer to the blank area of the desktop.
(ii) Press right mouse button.

(iii) A pop-up list opens.
(iv) Hover the mouse over View option.
(v) A further list opens up on the screen.

(vi) Click on Large icons or Medium icons or Small icons.
(vii) Observe the changes.

(c) Sorting the icons :
(i) Move the mouse pointer on the blank area of the desktop.

(ii) Press right mouse button.
(iii) A pop-up list opens.
(iv) Hover the mouse over Sort by option.
(v) A further list opens having four options.
(a) Name : Arrange the icons alphabetically according to their names.
(b) Size : Arrange the icons according to the file size.
(c) Item type : Arrange the icons according to the type of item.
(d) Date modified : Arrange the icons according to the date it was last

modified.
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(vi) Select any option according to your choice and observe the
changes.

5. The taskbar is located at the bottom of the desktop. But you can move
it to either of the four sides of the desktop.

4. Editing In Microsoft Word 2016

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Cut, 2. (c) S, 3. (a) Thesaurus, 4. (a) Red, 5. (a) File.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Double, 2. Ctrl, 3. Review, 4. Z, 5. P.

C. Write T for True and F for False statements :
1. T, 2. F, 3. T, 4. T, 5. T.

D. Give the short cut keys for the following tasks :
1. Ctrl + N, 2. Ctrl + O, 3. Ctrl + S, 4. Ctrl P, 5. Ctrl + Z, 6. Ctrl + Y

E. Answer the  following questions :
The features of word 2016 are :
1. Create letters, reports, bills, books, etc. in a presentable way.

Edit the text like copy or move the text within a same document or
another document.

2. To start MS Word 2016, the steps are as follows :
(i) Click on Start but ton.

(ii) From the list, select All Apps op tion.
(iii) Double click on Word ap pli ca tion to open it.

The Word window opens.
(iv) Click on Blank doc u ment.

A new blank document will open.
(v) It has the default name “Document 1”, which can be changed when 

you save the document.
(vi) You will see a small blinking cursor at the beginning of the page.A 

cursor is that position from where the text can be typed.
When you start typing, the cursor moves automatically to the right
side.

3. To create a new file, the steps are as follows :
(i) Click on File menu.

(ii) Click on New op tion.
(iii) Select Blank doc u ment.
(iv) A new blank document opens with name Document 1.

4. To create a duplicate of the text, the steps are as follows :
(i) Select the text that you want to copy.

(ii) In Home tab, under Clipboard group, click on Copy command.
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(iii) Now, bring cursor at the position where you want to paste the
selected text.

(iv) In Home tab, under Clipboard group, click on Paste command.
5. The steps to move the text from one place to anoher are as follows :

(i) Select the text which you want to move.
(ii) Go to Home tab.

(iii) In Clip board group, se lect the Cut com mand.
(iv) Now, take the cursor to the position where you want to paste the

cut text.
(v) Click the Paste com mand in the Clip board group.

6. (A) Undo : Undo option is used to reverse the action of the last
command. Suppose you have deleted one line accidently. You can
press Undo button to reverse the Delete command. As a result, you
can see the deleted line back at the same position.
(B) Redo : Redo is used to reverse the action of Undo command.

7. Format Painter is used to copy the formatting of one text and apply it
to another text.

5. Formatting In Microsoft Word 2016

 Let Us Answer 

A. Multiple Choice Questions :
1. (b) Calibri, 2. (a) Bottom, 3. (c) Strikethrough, 4. (c) Underline,
5. (a) Bold.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Uppercase, 2. Superscript, 3. Paragraph, 4. Justify, 5. Formatting.

C. Write T for True and F for False statements :
1. F, 2. T, 3. T, 4. F, 5. F.

D. Match the following figures with the correct option :
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3. (c) Bold
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E. Answer the following questions :
1. We make bold or italicize the text to highlight the important points or

headings.
2. Superscript is used to place the selected text little higher than the rest

of the text while Subscript is used to place the selected text little lower 
than the rest of the text.

3. Alignment refers to the positioning of text on a page. Various types of
text alignment are, aligned to left, center, right or justify.

4. Changing Font Type : To change the font of the text, the steps are as
follows :
(i) Select the text whose font is to be changed.

(ii) Go to Home tab.
(iii) In Font group, click on arrow next to Font op tion.
(iv) A drop-down list comes on the screen with various fonts.
(v) Select the desired font.

(vi) The font will be applied to the selected text.
Changing Font Size : To change the color of the text, take the
following steps :
(i) Select the text whose size is to be changed.

(ii) Go to Home tab.
(iii) In Font group, click on arrow next to Font Size option.
(iv) A drop-down list comes on the screen with various size options.
(v) Select the size according to your requirements.

(vi) The text size will be changed accordingly.
5. The purposes of different text cases are as follows :

(a) Sen tence Case : In this case, the first let ter of the first word will be
cap i tal and rest of the text will re main same.

(b) Lower Case : In this case, all the letters in the selected text will be
converted into small letters.

(c) Uppercase : In this case, all the letters in the selected text will be
capitalized.

(d) Capitalize Each Word : In this case, each word in the selected
text will have the first character in uppercase.

(e) Toggle Case : In this case, all the letters which are in uppercase
will be converted in lower case and all the letters in lowercase will
be converted in uppercase.

6. We can also apply border around the paragraph or the entire page.A
shading effect can also be provided to it. Let us see how we can do it.
(i) Click anywhere in a paragraph.

(ii) Go to Home > Paragraph group.
(iii) Click on drop-down arrow next to Borders option.
(iv) A list of borders appears.
(v) Select Borders and Shading option.

(vi) A Borders and Shading dialog box appears on the screen.
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(vii) A Borders tab is selected by default. If not, select the Bor ders tab.
(viii) You can choose the type of border for your paragraph.

(ix) You can select the Style by moving the scroll bar of Style option.
(x) Click on the drop-down arrow of Color and select the color of the

paragraph.
(xi) Select the thickness of the border by clicking on drop-down arrow

of Width option.
(xii) You can preview the border in the Preview section.

(xiii) Click OK button.
(xiv) A border gets applied to the paragraph. Look at the following

picture.
We can apply the border around the entire page too. For this, the
steps are as follows :

(i) Select the Page Border tab in Borders and Shading dialog box.
(ii) Select the Border type, Style, Color and Width.

(iii) Click on the drop-down arrow of the Art option.
(iv) You will see a list of art available that can be applied to the border.
(v) Select any of your choice by clicking on it.

(vi) You can preview your border in Preview section.
(vii) Click OK button.

(viii) The border gets applied to the entire page.
To apply the Shading to the paragarph :

(i) Click on the Shading tab in Borders and Shading dialog box.
(ii) Click on the drop-down arrow of the Fill option.

(iii) Select any color and that will be applied to be chosen paragraph.
(iv) The pattern list has a number of patterns.
(v) Select color to be applied with pattern.

(vi) The preview appears in the Preview section.
(vii) Select Apply to : Paragraph.

(viii) Click OK button.

6. Working With MS Paint

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Zoom in, 2. (b) Microsoft Paint, 3. (a) Microsoft, 4. (b) 90°, 
5. (c) Free-form.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. foreground, 2. Invert Selection, 3. move, 4. Skew, 5. Clipboard.

C. Write T for True and F for False statements :
1. T, 2. T, 3. F, 4. T, 5. F.
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D. Match the following figures with the correct option :

E. Answer the following questions :
1. Microsoft Paint is an application software. It allows you to draw your

imagination and color or pait it by using various tools.
2. Two features of MS Paint are as follows : 

(i)  MS Paint is used to create drawings, edit and print them.
(ii) We can draw different shapes with shapes tool.

3. Color 1 is foreground colour while Color 2 is Background colour.
4. Copying an object means to create its duplicate. The object will

appear both at the source and destination position.
Moving an object means to place it from one place to another. It will
appear only at the destination position but not at the source position.

5. Using crop command, we can crop the image and remove the
unwanted portion of the image from the drawing.

6. The Shape tool has various types of shapes which can be used to
creats various types of drawings.

7. (a) Rect an gu lar Se lec tion Tool : With the help of this tool, we can
se lect a pic ture or a part of it in a rect an gu lar form.

(b) Free-form Selection : Free-form Selection is like a free-hand
selection, in which you select a picture or a part of it in an irregular
shape.

8. In Paint, the image can be rotated in the given steps : 
1. Select an image using any Selection tool.
2. Now go to Home tab.
3. In Image group, click on Flib or Rotate command.
4. A drop-down list opens.
5. Select any Rotate or Flip option and observe the change in your

selected image.

  COMPUTER APPLICATION-4

1. Input, Output And Storage Devices

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Internal Memory, 2. (c) Mouse, 3. (a) 8, 4. (c) Inkjet, 5. (b) Scanner.
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B. Fill in the blanks by choosing the correct word from the given
bracket :
1. RAM, 2. IPO, 3. Web Camera, 4. Speakers, 5. keys.

C. Write T for True and F for False statements :
1. T, 2. T, 3. T, 4. F, 5. F.

D. Give the full forms of :
1. Input Process Output
2. Compact Disk
3. Light Emitting Diode
4. Cathode Rays Tube
5. Liquid Crystal Display.

E. Short Answer Type Questions :
1. A computer is an electronic device. It is able to do multiple tasks at a

time. There are many devices (also called peripherals) that can be
attached to the CPU to increase the work efficiency and usefulness of
the computer.

2. IPO Cycle means Input-Process-Output Cycle which happens in a
computer system. It means input of data where it is processed to give
an output.

3. Primary memory is also known as the internal memory or main
memory of the computer. It is the in-built memory that stores the data
and instructions while working. A computer cannot run without it. It
is referred as the working memory of the computer and is very costly.

4. Secondary memory is also known as the external memory of a
computer system. It can be stored for a longer period of time and can
be used whenever required. As the primary memory has less storage
capacity, these are more beneficial to store data. Moreover, the data
does not get lost when computer is powered off. It is also known as
auxiliary storage.

5. The processing or major device of computer handles all the operations 
occurring in the system. It is responsible for each and every action that 
takes place in the computer. It is the brain of the computer that
controls all the parts of the computer and does all kinds of simple and
complex calculations. It gets the input from input devices, processes it 
and give the result with the help of output devices.

6. The scanner is used to convert the hard copy into a soft copy which is
then stored in the computer.

7. The two different types of memories are primary memory and
secondary memory.

F. Long Answer Type Questions :
1. The different parts of a computer system are :

(a) Processing Devices (b) Output Devices (c) Storage Devices.
2. CPU processes the data according to the given instructions.
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3. (a) LED Mon i tor : The full form of LED is Light Emit ting Di ode. It is 
a screen dis play tech nol ogy that con tains a panel of LED’s which
pro duces out put on the screen.

(b) Laser Printer : The technology used in laser printer to generate
printout is the focused beam or light that transfers the text or
images on to a paper. The ink used for printing is in the form of a
dry powder. These are more expensive and commonly used these
days.

4. RAM (Random Access Memory) : It is the memory that allows the
data to be executed and stored for a limited amount of time. It erases
the data when the computer is switched off or power goes off. It is a
volatile memory.
ROM (Read Only Memory) : It is the memory that stores the data
permanently in the computer. It is a non-volatile memory which
means the data is not lost when the computer is switched off. It
contains the instructions to start a computer which can be read only
but never edited.

5. Hard Disk : It is a data storage device that stores and retrieves the
data with the help of magnetic disks. It is major storage area of a
computer and fixed inside the CPU. These days portable hard disks
are also available so that data can be transferred easily. It is also called 
as hard drive.
Floppy Disk : It is a storage medium including thin and flexible
magnetic disk inside a plastic carrier which helps to read and write
data to and from a computer system. A computer must have a floppy
disk drive (FDD) in order to read and write data from a floppy disk.

6. This device is used on the computer display screen to give input to the
computer. It is sensitive in nature as it contains sensors that correlate
with the screen to send the input to the computer system. The users
can use this pen carefully to point the icons and draw different
pictures as if they are working with pen and paper.

7. The major components of a CPU are :
Memory Unit (MU) : This unit stores the information temporarily or
permanently in its memory.
Arithmetic and Logical Unit (ALU) : This unit performs all the
arithmetic and logical operations for the computer.
Control Unit (CU) : The control unit directs the system to perform all 
the instructions. It does not execute any instruction but only directs
the path to execute the instructions or programs.

2. Managing Files And Folders

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Cortana, 2. (c) Desktop, 3. (c) Microsoft Edge, 4. (c) New,
5. (a) 2015.
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B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Folder, 2. Icon, 3. Windows 1.0, 4. Windows 10, 5. Windows Store.

C. State T for True and F for False statements :
1. T, 2. F, 3. F, 4. T, 5. F.

D. Match the pictures on the left with their names on the right :

E. Short Answer Type Questions :
1. Windows 10 is the latest version of Windows Operating System.

Microsoft Edge is the default browser of Windows 10
2. The first screen that opens up after the loading is called a Desktop.
3. Any information in a computer is saved in the form of a file.
4. Folder in a computer is like a cabinet where we keep relevant files. A

folder within a folder is called subfolder.
5. The steps to check the properties of any file or folder are as follows :

(i) Right click on any file or folder.
(ii) A pop-up list opens.

(iii) Select the Properties option from the list.
(iv) A Properties window appears on the screen.
(v) You can check the properties by clicking on the respective tab like

type of folder, date and time of creation, size of folder, security
and sharing properties, etc.

6. Take the following steps to remove the file or folder from the
desktop :
(i) Right click on the file or folder which is to be deleted.

(ii) A pop-up list opens.
(iii) Select the Delete option.
(iv) The folder will be removed from the desktop and moved to

Recycle Bin.
7. The Shortcut is an icon which provides an easy and quick method to

open any application or software that we use frequently is called a
shortcut. There is a small jump arrow present at the lower left corner
of the shortcut icon.

8. The steps to rename a file/folder are as follows :
(i) Take the mouse pointer to the file or folder whose name is to be

changed.
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(ii) Right click on it.
(iii) A pop-up list opens.
(iv) Click on Rename option.
(v) The file or folder name will get highlighted.

(vi) Now, type the new name for it.
(vii) Press Enter key from the keyboard.

F. Long Answer Type Questions :
1. The various features found in Windows 10 are :

(i) Start Menu Returns : Microsoft has finally brought back the
Start menu which was taken back in Windows 8. When you click
on Start menu at the bottom left corner of the desktop, two panels
side by side appears. The left panel showing pinned and the right
panel showing recently and most-used apps.

(ii) Cortana on Desktop : Windows 10 has brought Microsoft’s
voice-controlled digital assistant Cortana to desktop
computers.With the help of it, you can interact with your device
without lifting a finger. For this, you need a microphone. It can
also help you to launch PowerPoint presentations just by telling
your PC to do so. You can also send an email while you are
working on a spreadsheet, make multitasking much easier.

(iii) Xbox app : You can also play Xbox One game on your PC or
tablet, with Xbox app for Windows 10. The new operating system
will support Xbox game streaming with improved speed and
graphics performance.

(iv) Microsoft Edge Browser : In windows 10, Microsoft Edge is the
default browser. Using this, we can write and highlight directly on
web pages. Corbina is an-built feature of Microsoft edge, with its
help, you can do things better.

(v) New Looks : Windows 10 comes with a new and attractive look
with the blue highlighting features. You can see new pictures,
graphics, styles, themes and allows you work in a new
environment.

(vi) Windows Store : Microsoft provides a Windows Store which
contains various paid and free apps, games or movies. You can
download the free apps if required or pay to buy any paid app.

2. The Start button is probably the most used button on the Windows
desktop. It looks like a small window. When we click on this button,
start menu appears with two panels. The first panel shows the list of
various options which can be used to open a particular application,
power button to shutdown or restart the system and most used
applications.

3. This PC icon is same as My Computer icon in previous versions of
windows. This icon is used to contains drives by clicking on which we 
can see the contents in it. We can see the contents of hard disk,
CD/DVD, or other external storage devices.
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4. File Explorer is an application that provides detailed information
about files, folders and drives. It enables us to access, edit, manage
and organise our files and folders. We can view the files and folders in 
it, create new folder, copy or move the file or folder, remove it and so
on.
Opening File Explorer : To open File Explorer, the steps are as
follows :
(i) Click on Start button.

(ii) From the list, select File Explorer option.
(iii) The File Explorer window opens.
(iv) It looks same as This PC window.
(v) It consists of two panes.

(vi) Left pane shows the list of icons, files and folders in hierarchical
format.

(vii) Right pane shows the contents of the file or folder you have
selected in the left pane.

5. The method to create a file an example is as follows :
(i) Open Word 2016 application software.

(ii) Now, open a Blank Document.
(iii) Type some contents in it.
(iv) After completing your work, you need to save the file.
(v) To save a file, go to File > Save As.

(vi) A Save As dialog box opens.
(vii) Select the location where you want to save the file.

(viii) Type the name for the file in File name : text box.
(ix) Click on Save button.
(x) Close the Word 2016.For this click on Close button at the top right

corner of the window.
6. The steps to create a folder are as follows :

(i) Right click on the blank area of the Desktop screen.
(ii) A pop-up menu appears.

(iii) Hover your mouse pointer on New option.
(iv) A sub-list opens.
(v) Select the Folder option.

(vi) A new folder will be created and shown on the Desktop screen.
(vii) It has a default name “New Folder”.

(viii) You will see that it is highlighted, so that you can type the new
name for it.

(ix) Type the new name of the folder and press Enter key from the
keyboard.
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3. More On Microsoft Word 2016

 Let Us Answer 

A. Multiple Choice Questions :
1. (b) Brush, 2. (c) Home, 3. (a) Header, 4. (b) Web Layout,
5. (a) selected.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. 1", 2. Find, 3. Print Layout, 4. Portrait, 5. Outline.

C. Write T for True and F for False statements :
1. T, 2. F, 3. T, 4. F, 5. F.

D. Write the names of the tabs under which these tools are located :
(a) Layout, (b) View, (c) Home, (d) Home.

E. Short Answer Type Questions :
1. The Replace tool searches the text we like to change, and replace it

with something else.
2. The three properties under Page Setup Group are, Margins,

Orientation and Size.
3. The For mat Painter Tool is used to ap ply the text for mat ting op tions

of a text to an other text in a doc u ment. 
4. Header tool allows us to insert some information on top of every page.
5. Preview the document means to check a document for any faults

before generating its printed and hard copy.
6. Draft view allows us to view the document as a draft. This will help to

edit the text quickly without showing certain objects in the document.
F. Long Answer Type Questions :

1. The Format Painter Tool is used to apply the text formatting options
of a text to another text in a document. This can be font size, style,
color or other formatting options.

2. Header and footer tool helps to insert some information on top and at
the bottom of every page respectively. It allows us to add name of the
topic, chapter number, page number, date, any title, name of the
author,  etc.

3. (a) Print Lay out View : This is a de fault view, we can see it
when ever any doc u ment is opened. It con tains ev ery com po nent
and tools re quired for writ ing a document.

(b) Web Layout View : This view helps the user to view the
document as a webpage. It is more creative if it includes different
shapes, images, tables, etc.

4. Find tool is used to find a particular text in a document whereas,
Replace tool searches the text we like to change, and replace it with
something else.
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4. Working With Styles And Objects

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Two, 2. (a) Insert, 3. (b) Table, 4. (a) Format, 5. (c) Both of them.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Symbols, 2. Screenshot, 3. Textbox, 4. Internet, 5. Shape.

C. Write T for True and F for False statements :
1. T, 2. T, 3. F, 4. T, 5. T.

D. Short Answer Type Questions :
1. A text box tool is the one through which we can enter text.
2. The three objects that can be inserted in a document are, Pictures,

Textbox and Symbols.
3. The screenshot is like a picture captured of a screen which can be used 

in Word, Excel, Outlook and PowerPoint. 
4. Using Online  Pictures Tool, we can also add pictures directly from

the internet.
5. Style means the appearance of the text.
6. The table is a collection of rows and columns.

E. Long Answer Type Questions :
1. To insert a shape in the document, the steps are as follows :

(i) Click on Insert tab. Go to Shapes option under illustrations
group and click on it.

(ii) Choose any shape of your choice and drag the mouse on the
working area. The selected shape will be drawn on the page.

(iii) As the shape appears on the page, a Format tab related to the
Shape Styles will appear as well where you can change the
appearance of the Shape by giving different effects to it.

(iv) To add text in a shape, right click on the shape. Click on Add Text
option from the shortcut menu. The insertion pointer will appear in 
the shape where you can type anything.

(v) To apply shadow to a shape, click on Shape Effects option in
Shape Styles group. Go to Shadow option and choose any
shadow of your choice and it will be applied to the shape.

2. In Microsoft Word 2016, WordArt feature allows us to create special
text effects. It provides a unique look to the text. Using WordArt, you
can create decorative effects, such as curved, heavy, shadowed,
3-dimensional, etc.

3. (a) In sert ing Pic tures : We can add pic tures in our doc u ment. It helps 
us to il lus trate the in for ma tion in a better way. This also up grades
the qual ity of the doc u ment as pic tures at tracts the audience.

 (b) Inserting Online Pictures : Inserting online pictures means to
add pictures directly from the Internet.
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4. To add a table in a document, the steps are as follows :
(i) Click on Insert tab. Go to Table option under Tables group and

click on it.
(ii) Click on Insert Table option.

(iii) An Insert Table dialog box comes on the screen. Give the number 
of rows and columns in the respective textboxes and click OK
button. The table will be drawn on the page.

(iv) Enter the data in the table.
(v) As the table is added on the page, a Format tab related to the Table 

tools will appear as well where you can change the appearance of
the table by giving different effects to it.

5. To insert a shape in the document, the steps are as follows :
(i) Click on Insert tab. Go to Shapes option under illustrations group 

and click on it.
(ii) Choose any shape of your choice and drag the mouse on the

working area. The selected shape will be drawn on the page.
(iii) As the shape appears on the page, a Format tab related to the

Shape Styles will appear as well where you can change the
appearance of the Shape by giving different effects to it.

(iv) To add text in a shape, right click on the shape. Click on Add Text
option from the shortcut menu. The insertion pointer will appear in 
the shape where you can type anything.

(v) To apply shadow to a shape, click on Shape Effects option in
Shape Styles group. Go to Shadow option and choose any
shadow of your choice and it will be applied to the shape.

5. MS PowerPoint 2016

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) PowerPoint, 2. (a) MS PowerPoint, 3. (c) 2015, 4. (b) Tabs, Group,
5. (a) Navigation Pane.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. F5, 2. Alt + F4, 3. Slide Pane, 4. Template, 5. Save.

C. Write T for True and F for False statements :
1. F, 2. F, 3. T, 4. T, 5. F.

D. Do it Yourself.
E. Short Answer Type Questions :

1. Presentation is a software application designed to present the graphics 
information in the form of a slide dhow.

2. A slide is a page which can be created to give information on a topic.
3. PowerPoint is used to create presentations.
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4. PowerPoint Application can be started as follows :
(i) Click on Start button.

(ii) Select the PowerPoint from the right pane by clicking on it.
(iii) Or go to Start> All apps> PowerPoint option.
(iv) A PowerPoint window opens.
(v) Click on Blank Presentation.

(vi) A new blank presentation opens titled Presentation 1.
5. To close the PowerPoint application, the steps are as follows :

(i) Click on File menu.
(ii) Click on Close option.

F. Long Answer Type Questions :
1. Four features of PowerPoint 2016 are as follows :

(i) PowerPoint De signer : When you in sert an im age in a Slide, you
will see that a De sign Ideas pane ap pears at the right side of the
win dow. This pane shows the var i ous lay outs for the im age. You
can se lect and click any lay out. If you don’t want to se lect any
lay out from the pane, just close the pane and cre ate your own
layout.

(ii) New Office Themes : Microsoft provides new four office themes
in PowerPoint. The four office themes are Colourful, Dark Gray,
Black and White. To change your office theme, go to File
Account, then click the drop down menu next to Office Theme.

(iii) Quick Shape Formats : When you draw shape in a slide, you
need not to waste time to create effects manually. It provides
number of presets which will expand your color and formatting
options.

(iv) Morph Transition : A new transition type is added in PowerPoint 
which is used to automatically animate, move and emphasize the
objects in slides.

2. To  create a new PowerPoint presentation, follow the given steps :
(i) Go to File menu.

(ii) Click on New option.
(iii) Click on Blank Presentation.
(iv) A new blank presentation window opens.

3. To open an al ready cre ated pre sen ta tion, follow the given steps :
(i) Click on File menu.

(ii) Click on Open option.
(iii) Click on Browse option.
(iv) An Open dialog box opens.
(v) Now, type the name of the file or select the file which you want to

open.
(vi) Click on Open button.

(vii) The presentation file will get open.                    
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4. A template is a blueprint of slide which contains layout, theme,
colors, theme effects, background styles, etc. Follow the given steps
to create a new presentation using Templates :
(i) Click on File menu.

(ii) Click on New option.
(iii) A window opens containing various templates in the form of

thumbnails.
(iv) Select any template by clicking on it.
(v) It will display the various layout options for the template you have

selected.
(vi) Select the layout of your choice and click Create button.

(vii) Your presentation will be created with the selected template.
5. If you use Save As option for an existing presentation, you can create

a duplicate file with a new name. To save an existing file the steps are
as follows :
(i) Click on File menu.

(ii) Click on Save As option.
(iii) Click on Browse option.
(iv) By this, A Save As dialog box opens.
(v) Type the name of the file and click Save button.

6. More in PowerPoint

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Insert, 2. (b) Title and Content, 3. (c) Normal, 4. (c) Illustrations,
5. (c) Text Effects.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Format Painter, 2. WordArt, 3. one, 4. any, 5. presentation.

C. Write T for True and F for False statements :
1. T, 2. F, 3. F, 4. T, 5. T.

D. Short Answer Type Questions :
1. Slide contents are text, chart, table, smart art, pictures, etc.
2. To delete a slide from the presentation, take the following steps :

(i) Go to Navigation Pane.
(ii) Right click on the slide which you want to delete.

(iii) From the pop-up list, select Delete Slide option.
(iv) Or select the slide and press Delete key from keyboard.

3. This layout is used to add title and contents in a slide like text, chart,
table, smart art, pictures, etc.

4. Changing Font :
(i) Select the text whose font is to be changed.

(ii) Go to Home tab.
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(iii) In Font group, select the drop-down arrow next to Font.
(iv) Select the desired font.

Changing Font Color :
(i) Select the text whose font color is to be changed.

(ii) Go to Home tab.
(iii) In Font group, select the drop-down arrow next to Font Color.
(iv) Select the desired color.

5. (i) Select the text.
(ii) Go to Home tab.

(iii) In Paragraph group, select any of the alignment options.
(iv) The text will be aligned accordingly on a slide.

6. The object can be a picture, text, or shape.
(i) Click on the object.

(ii) You will see a circular arrow when you select an object.
(iii) Click on the circular arrow, a pointer changes its shape to rotation

handle.
(iv) Now, drag the mouse and you will notice that shape is rotating

with it.
E. Long Answer Type Questions :

1. Different slide layouts are as follows :
 (i) Ti tle Slide : This is the ba sic lay out. It is ba si cally used to add ti tle

and sub ti tle in a slide.
(ii) Title and Content : This layout is used to add title and contents in

a slide like text, chart, table, smart art, picture, etc.
(iii) Section Header : It has a title field and area to add text.
(iv) Two-Contents : This layout is divided into three sections. In the

top, you can add title of the slide. In the remaining sections, you
can add slide contents like text, chart, table, smart art, pictures,
online pictures and video clips.

(v) Comparison : This layout is used for comparison purpose. It
looks like Two-Contents Slide but have two additional
placeholders.

(vi) Title Only : This layout has only title field in which you can add
title of the slide.

(vii) Blank : This slide is completely blank. It allows us to design our
own slide.

(viii) Content with Caption : This layout is divided into three sections.
The left side contains the title and text. The right side contains the
other elements like chart, table, pictures, smart art, etc.

(ix) Picture with Caption : The upper part of the slide contains the
picture and lower part contains the caption and description.

2. Text can be formatted in a slide by changing font, font color, font size, 
using bold, italic, underline, and Bullets and numbering options.
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3. (a) Add Bullets and Numbering :
(i) Place the cursor at the position where you want to insert bullet of

number.
(ii) Go to Home tab.

(iii) In Paragraph group, click on the drop-down arrow next to
Bullets or Numbering button.

(iv) Select the desired style.
(v) A bullet or number will get inserted at the cursor position.

(b) Use Format Painter :
(i) Select the text whose formatting you want to copy.

(ii) Go to Home tab.
(iii) In Clipboard group, select the Brush icon (Format Painter

option).
(iv) Now move the mouse at the starting of the text where you want to

copy the formatting.
(v) Click and drag the mouse over the text.

(vi) You will see that the formatting is applied on the text.
4. WordArt is used to change the style of the text by giving it an artistic

look. The steps to insert WordArt in slide are as follows :
(i) Go to Insert tab.

(ii) In Text group, select drop-down arrow next to WordArt.
(iii) A WordArt gallery appears.
(iv) You can select any WordArt style.
(v) A placeholder appears on the slide.

(vi) Click in the placeholder, a cursor appears.
(vii) Type “My first Presentation” in the placeholder.

(viii) Now, select the text.
(ix) Click on Format tab.
(x) In WordArt styles group, select Text Fill option.

(xi) Select the required option and see the change in your text.
(xii) Select Text Outline drop-down arrow.

(xiii) Select the desired option and that will be applied to the text.
(xiv) Select Text Effects drop-down arrow.
(xv) Click on any option and select the desired effect.

(xvi) You can observe the change in the text.
5. Different types of shapes can be inserted in a slide. They may be basic

shapes like rectangle, circle, pentagon, diamond, or triangle; lines,
equation shapes, flowchart shapes, etc. These shapes can be resized,
rotated, colored and flipped.
We can format the shapes in a slide using Shape Styles, Shape Fill,
Shape Outline and Shape Effects.
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 7. Internet

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Local, 2. (c) Web Address, 3. (c) Web Site, 4. (a) Modem.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Google Chrome, 2. Refresh, 3. Microsoft Edge, 4. ISP, 5. e-shopping.

C. Write T for True and F for False statements :
1. T, 2. F, 3. F, 4. T, 5. T.

D. Short Answer Type Questions :
1. Communication means to share ideas, thoughts and feelings with

another person. It may be face-to-face, or to the person who is sitting
at the other corner of the world. Internet has made it possible for
people to communicate with each other who are geographically far
away.

2. Internet is a very large network of computers. Millions of computers
are connected all over the world through the internet. These
computers are connected to each other to share information and
resources. Internet is also called Wide Area Network (WAN).

3. A web page is just like a page of information. The information it
contains is related to the web site, of which it is a part. It contains
information in the form of text, audio, video, pictures, graphs, table or
hyperlink.

4. A web site is a collection of web pages. It is like a book containing
various pages with information. The information available on the
internet is contained in web sites.

5. When you open a website, the first page which opens is called a Home 
Page. It contains a link to other web pages.

6. WWW, World Wide Web or W3 is a large database of information,
which can be accessed by the user. The information it contains may
include text, picture, videos, animation, etc.

E. Long Answer Type Questions :
1. A computer network is a group of two or more computers that are

connected to each other to share information and resources.
2. To get connected to the internet, one should have the following basic

requirements :
(a) Computer : You must have a computer whose minimum

requirements for network connectivity and other functions should
be 4GB RAM and 500GB hard disk space in the computer.

(b) Modem : A Modem stands for Modulator/Demodulator. It is
needed to change digital signals from computer to analog signals
which can be transferred over telephone lines and vice versa.
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(c) Internet Service Provider (ISP) : ISP is a company who provides 
the internet connection to people. It creates an internet account for
the user and assigns a username and password. User can login to
the internet by typing his username and password to the computer
and use the internet services. ISP also charges the fees from the
internet user which depends upon the type of connection and
usage. Examples : MTNL, BSNL, Connect, VSNL, Airtel,
Vodafone, etc.

3. Four internet services are as follows :
(i) Any kind of information can be accessed from the server by sitting

on the client computer.
(ii) Various search engines have been provided to search information

on any topic on internet. For Example, Google.
(iii) Internet allows you to communicate with others by sending and

receiving text messages, voice messages or video calls.
(iv) E-mail allows you to send mails to any person around the world

within few seconds.
4. The web site consists of web pages. It is like a book containing

various pages with information. The information available on the
internet is contained in web sites whereas the web page is just like a
page of information. The information it contains will be related to the
web site, to which it is a part. It contains information in the form of
text, audio, video, pictures, graphs, table or hyperlink.

5. The web server is a software program that is installed on server
computer. When a client sends request, it uses HTTP (Hyper Text
Transfer Protocol) to transfer the web page to the client whereas the
web browser is a software that lets you access the pages on the World
Wide Web. It can be used to communicate with the web server and get 
information on WWW.

6. The default web browser on Windows 10 is Microsoft Edge. It has
replaced Internet Explorer, which was the default browser on all
devices. Microsoft Edge was released with Windows 10 on August
2016.

COMPUTER APPLICATION-5

1. Evolution Of Computers

 Let Us Answer 

A. Multiple Choice Questions :
1. (b) Abacus, 2. (a) Charles Babbage, 3.  (c) Micro, 4. (a) First
Generation, 5. Palmtop.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Charles Babbage; 2. 1673; 3. Super; 4. Fifth; 5. First.
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C. Write T for True and F for False statements :
1. F, 2. T, 3. T, 4. T, 5. T

D. Match the followings figures with correct computer :

E. Short Answer Type Questions :
1. An electronic machine that can store, find and arrange information,

calculate amounts and control other machines.
2. Computers are being increasingly used for every type of work, be it

education, research, industry, business, medicine, law, fashion or
sports.

3. The idea behind the invention of computer was to make a device
which could perform mathematical calculations.

4. Punched cards are used to store informations and do calculations upto
20 decimal places.

5. The Tabulating  Machine was invented by Herman Hollerith. It was
an electrical device that rapidly stored and analysed information
recorded on punched cards. This machine was capable of reading,
sorting and summing the data. This machine processed data
mechanically.

F. Long Answer Type Questions :
1. (a) Abacus was the first mechanical device used for calculations. It

was invented in China, thousands of years ago. It was the first
calculating device which could perform counting, addition and
subtraction. It is made up of wooden frame having rods with
beads.

(b) It was designed by a British mathematician Charles Babbage in
1822. It used punched cards to store information and do
calculation up to 20 decimal places. It is called Difference Engine
because it is based on mathematical principle namely, the method
of finite differences.

(c) It is also designed by Charles Babbage. It would have been the
world first general-purpose computer that had five units- Input,
Output, Store, Mill and Control. All the computers used nowadays 
are based on this machine. Input and Output units are used to enter
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data and display results respectively. Store is used to store the
data. Mill is used to perform calculations and control unit is used
to control the overall working.

2. Advantages and Disadvantages of Generations of Computers :

Generation Ad van tages Disadvantages

First
Generation

1. Vacuum tubes
made possible the
advent of electronic
digital computer.

2. Computers could
perform
calculations in
milliseconds

1. Vacuum tubes
produced lot of heat
and burnt out
frequently.

2. Systems needed to be 
kept in
air-conditioned
rooms.

3. Bulky in size and
non-portable.

Second
Generation

1. Generated less heat.

2. Computations were
performed in
microseconds

1. Air-conditioning was
required.

2. Frequent maintenance 
was required.

Third
Generation

1. Smaller in size as
compared to
previous
generations.

2. Produced less heat.

3. Calculations were
performed in
nanoseconds.

1. Air conditioning was
required.

2. Highly sophisticated
technology required
to manufacture
integrated circuit
chips.

Fourth
Generation

1. Smaller in size.

2. No air-conditioning 
is required.

3. Fast Calculations
and not expensive.

1. Highly sophisticated
technology required
to manufacture
integration chips.

Fifth
Generation

1. Able to think and
reason.

2. Machines with
genuine I.Q.

1. Highly sophisticated
technology required.

2. Still in progress.
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3. Micro Computers :
Micro computers are designed for personal use. They are also called
Personal Computers. They are small and cost effective. A micro
computers uses a microprocessor, graphics, processing unit, network
chips and memory. They are found in home, office, schools, shops,
etc.
Ex am ple : Cell phone, Palm Com puter, Tab let, Lap top, Desk top
com puter.
Some micro computers have been explained below :

(a) Laptop : A laptop or Notebook is a kind of micro computer than can
be used on laps and easily portable. It has same hardware and software 
as desktop, but they are compact and lighter. Basically, laptos are
battery operated and largely used by office employees and home
users.

(b) Desktop Computers : Desktop Computers are kept on desk or table
and commonly found in schools, banks, offices, railway, airport,
hospitals etc. They come with input (keyboard and mouse), output
unit (monitor and printer) and processing unit (CPU).

(c) Palmtop Computer : A Palmtop is a micro-computer that fits in a
palm or hand and can be carried in a pocket. It has a pen like device
which is used to select options. It stores less data compared to other
computers but can be easily carried everywhere.

4. A mini computer has most features and capabilities of a large
computer but is small in size. It was primarily designed for business
applications and services. It has a higher processing speed and is more 
expensive than a micro computer. 
On the other hand a micro computer, also called personal computer, is
designed for personal use. It is small and cost effective. It comprises
of a microprocessror graphics processing unit, network chips and a
memory. It can be seen at homes, schools, shops and offices.

5. Super Computers
A Super computers is more powerful and fastest computer. It has
many microprocessors in it to do complex work. Super computer are
very expensive and are used in specialised area like weather
forecasting, scientific research, atomic science, animation films
defence, space applications, etc.
Example : Cray XC40, Sunway TaihuLight.

2. Understanding Windows 10

 Let Us Answer 

A. Multiple Choice Questions :
1. (b) Windows 10, 2. (a) Desktop, 3. (c) Personalization option,
4. (a) Notification Area, 5. (c) Icons.
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B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Weather, 2. right, 3. Cascade windows, 4. This PC.

C. Match the following figures with the correct option :

D. Write T for True and F for False statements :
1. T, 2. T, 3. T, 4. F, 5. T.

E. Short Answer Type Questions :
1. Windows provides a Graphical User Interface (GUI) to the users. It

contains various images, pictures, menus, buttons, diagrams, graphs,
etc. which through we can easily work on such Operating system.

2. Windows 10.
3. Windows Desktop is screen that appears when you switch on the

computer. It is also known as the opening screen of windows. It
consists of Icons, Shortcuts, Folders, Desktop Background and
Taskbar.

4. GUI contains various images, pictures, menus, buttons, diagrams,
graphs, etc.

5. Taskbar is the long horizontal bar which is present at the bottom of the 
desktop.

6. The steps to resize tiles are as follows :
(i) Right click on the tile.

(ii) From the pop-up list, hover mouse over Resize option.
(iii) It will show the options like Medium or Small.
(iv) Select the desired option and observe the change in the size of the tile.

F. Long Answer Type Questions :
1. An icons is a small picture that represent a file, folder or a program.

We can open any program directly, by double clicking on its icon. The 
icons which are always present on the desktop are :
This PC, Network, Recycle Bin.

2. Four new features found in Windows 10 are :
(i) Microsoft has finally brought back the Start menu which was

taken back in Windows 8.
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(ii) When you click on Start menu at the bottom left corner of the
Window, you will see two panels side by side. The left panel
showing pinned and the right panel showing recently and
most-used apps.

(iii) Windows 10 has brought Microsoft’s voice-controlled digital
assistant Cortana to desktop computers.

(iv) You can also play Xbox One game on your PC or tablet, with box
app for Windows 10.

3. Taskbar is the long horizontal bar which is present at the bottom of the 
desktop.

4. At the left most side of the taskbar, you can see Start button. When
you click on this button, a list opens containing various options. This
list is known as Start Menu. You can navigate through the list and
options and open the required application by selecting the option. You 
can also Sleep, Shut Down or Restart the computer by selecting The
Power option from the Start menu.

5. (a) Pin ning to Start : (i) Go to Start >All apps.
(ii) Move the mouse pointer on the app and right click on it.

(iii) From the list, click on Pin to Start.
(iv) You will observe that the app is displayed as tile to the right pane.

(b) Unpin from Start : (i) Go to Start > All apps.
(ii) Right click on the app which you want to unpin.

(iii) Select Unpin from Start.
(iv) You will see that the app is unpinned from the right panel.

(c) Turn Live Tiles Off : (i) Go to Start > All apps.
(ii) Right click on Tile.

(iii) Hover your mouse pointer on More.
(iv) From the list, select Turn Live Tile Off option.

6. There are some apps which can work on all the devices such as phones 
and tablets to laptop and desktop systems. When you click on the
Start button, you can see the universal apps on the right panel. These
may include Weather, Photos, Mail, Cortana, Maps, Mail, Calendar,
etc. These apps are the part of Windows Store. Some of the apps are as 
follows :
Calendar : It shows the current day and date. We can click on this file 
or app to have the view of current month, previous month and next
month. You can also perform some calendar settings by clicking on
Settings option.
Mail : You can use this app after sign in with your account. It allows
you to manage all the mail accounts at one place. It shows the
notifications about the incoming mails. You can also open the mail to
read it and reply.
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7. You can customize the desktop by changing some settings according
to your choice. Let us do it :
(i) Right click on the blank area on desktop screen.

(ii) Select Personalization option.
(iii) A Settings window opens.
(iv) In Personalization section, click on Colors option.
(v) Select the color from Windows Colors.

(vi) You can preview it in the Preview section.
(vii) If the checkbox-“Automatically pick an accent color from my

background”, is clicked, it will automatically select a color that
matches to the desktop wallpaper.

(viii) If you want the selected color to appear on the title bar, Start,
Taskbar and Action centre, click the corresponding check boxes to 
make it enable.

(ix) Choose the default app mode by clicking on the corresponding
radio button.

(x) Observe the change.
8. (a) Displaying Multiple Windows at a Time : We can display

multiple windows side by side on the desktop screen at the same
time.

(i) OpenWord 2016.
(ii) Open Scratch 2.

(iii) Now right click on the blank area on taskbar.
(iv) Select Show windows side by side option.
(v) You will see that both the windows are displayed side by side on

the desktop.
(b) Cascading Windows : In Windows, we can use the cascade

windows option to arrange all open windows to overlap one
another with their title bars remaining visible so you can quickly
see which windows are open to switch to one.
You can approach the window by clicking on its title bar.

(i) Open multiple applications at a time.
(ii) Right click on the taskbar.

(iii) Select Cascade Windows option.
(iv) You will see that all the windows are displayed in cascading form.

3. Tables In Word 2016

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) rows and columns, 2. (a) Gridlines, 3. (c) Text and Numeric,
4. (c) Shift, Alt, 5. (b) Insert.

B. Fill in the blanks :
1. Table, 2. Gridlines, 3. table, 4. Table styles, 5. table.
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C. Match the figures with the correct options :

D. Write T for True and F for False statements :
1. T, 2. T, 3. F, 4. F, 5. T.

E. Short Answer Type Questions :
1. MS Word is a word processing software.
2. Text and Numeric.
3. Merge means to combine multiple cells into a single cell.
4. A cell can be splitted or divided into multiple cells.

F. Long Answer Type Questions :
1. We can insert table in Word document by the following methods : 

(a) Using Grid, (b) Using Insert dialog box.
2. (a) In sert Rows and Col umns in a Ta ble : (i) To in sert a row, click

on the cell, ad ja cent to which you want to in sert a new row.
(ii) In Table Tools, select the Layout tab.

(iii) In Rows & Columns group, select Insert Above or Insert
Below options to insert a row above or below respectively.

(iv) Similarly, to insert a column, select the cell, adjacent to which 
you want to insert a new column.

(v) In Layout tab, under Rows & Columns group, select Insert
Left or Insert Right options to insert a column to the left side
or right side of the cell respectively.

(b) Delete Rows and Columns in a Table : To delete some unwanted 
rows or columns from the table, You can use Delete option from
Layout tab.
(i) Click on the cell which row or column you want to delete.

(ii) In Table Tools, click on Layout tab.
(iii) In Rows & Columns group, click on the drop-down arrow of

the Delete option.
(iv) Select Delete Rows or Delete Columns options according to

your choice.
(c) First Method : (i) Move the cursor to the lower right corner of a

table.
(ii) A pointer will change to double sided arrow.

(iii) Now, click and drag the mouse and size of the table changes
accordingly.
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3. (i) Type the text as shown in the figure.
(ii) Select the entire text.

(iii) Click on Insert tab.
(iv) In Tables group, click on drop-down arrow of Table command.
(v) Click on Convert Text to Table option.

(vi) A Convert Text to Table dialog box opens.
(vii) Specify Number of rows and Number of columns.

(viii) Click OK button.
4. (a) In sert Pic ture in Ta ble Cell : (i) Click in a cell where you want a

pic ture to ap pear.
(ii) Click on Insert tab.

(iii) In Illustrations group, select Pictures option.
(iv) The Insert Picture dialog box opens.
(v) Browse and select the picture that is to be inserted.

(vi) Click on Insert button.
(vii) You will see that the picture is inserted in a selected cell.
(b) Calculate the Table Values : (i) Enter a row at the bottom of the table.
(ii) Type ‘Total Sale’ in the first cell.

(iii) Click in the last cell.
(iv) Go to Table Tools and select Layout tab.
(v) Click on the drop-down arrow of the Data option.

(vi) Select Formula option.

4. Mail Merge

 Let Us Answer 

A. Multiple Choice Questions :
1. (b) Main Document, 2. (a) Mailing, 3. (c) Merging, 4. (b) Tab,
5. (c) Merge Field.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Creating a main document, 2. Data Source, 3. Main Document,
4. Mailings, 5. 

C. Write T for True and F for False statements :
1. F, 2. F, 3. T, 4. T, 5. F.

D. Match the following figures with the correct options :
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E. Short Answer Type Questions :
1. In companies and business houses, sometimes it may happen that the

same letter is to be sent to a number of people say clients, vendors,
share holders, etc. So the same letter are created with the different
addresses as creating separate letters for all the people is very time
consuming. Word provides a feature of Mail Merge in which we
create a data source which contains the addresses and merge it with
the mail contents. So, we need to write the contents once and mail
merge will do the rest.

2. The steps to create mail-merge documents are as follows :
(i) Creating a Main Document

(ii) Specifying a Data Source
(iii) Merging Data Source with Main Document

3. The main document is a document which contains the text or contents
of the mail. It will be created only one time.

4. The data source is the mailing list. It has the details of the recipient
like recipient name, address, phone number, pin code, city, etc. You
need to create a data source to contain the information of all the
recipients to whom you want to send the mail.

5. Merge fields are used to create multiple documents at the same time.
F. Long Answer Type Questions :

1. In companies and business houses, sometimes it may happen that the
same letter is to be sent to a number of people say clients, vendors,
share holders, etc. So the same letter are created with the different
addresses. Creating separate letters for all the people is very time
consuming. Word provides a feature of Mail Merge in which we
create a data source which contains the addresses and merge it with
the mail contents. So, we need to write the contents once and mail
merge will do the rest.

2. The steps to create mail-merge documents are as follows :
(i) Creating a Main Document

(ii) Specifying a Data Source

(iii) Merging Data Source with Main Document

3. The steps to create recipient list are as follows :
(i) In Select recipients section, click on Type a new list radio button.

(ii) In Type a new list section, click on Create button.

(iii) A New Address List dialog box comes on the screen.

(iv) Click on Customize Columns button.
(v) A Customize Address List dialog box opens which allows you to

add, delete or rename the fields you want to be in the recipient list.
Click OK button.

(vi) The fields you have added comes on the screen in the New
Address List.
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(vii) Now, make the entries for the fields in New Address Field dialog
box. Click on New Entry button every time to make a new entry.
Or you can click Tab button to move to next line.

(viii) Click Ok button.
(ix) A Save As dialog box comes on the screen.
(x) Select the location where you want to save the file and type the

name in File name textbox. Click Save button.
(xi) A Mail Merge Recipients dialog box comes on the screen.

(xii) It will display the details of the recipients you have created.
(xiii) Click OK button.
(xiv) Click on Next : Write your letter in wizard.
(xv) A next wizard is displayed.

4. The steps to insert merge fields to the main document are as follows :
(i) After creating recipient list, the next step is to merge the list with

the main document. For this, you need to place the cursor at the
position where you want to insert the merge fields.

(ii) Click on Mailings tab.
(iii) In Write & Insert Fields group, select the drop-down arrow of the 

Insert Merge Fields option.
(iv) Select the field which you want to insert at the cursor position.
(v) Again, place the cursor at a required position and Insert Merge

field.
5. The steps to view the merged data in a main document are as follows :

(i) Click on Mailings tab.
(ii) In Preview Results group, select Preview Results option.

(iii) Or click on Next : Preview your letters option at the end of the
wizard.

(iv) You will see that the first record is displayed at the place where
you inserted merge fields.

(v) Click on Next Record button to view the next record.

5. More On PowerPoint 2016

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Presentation, 2. (c) Photographs, 3. (c) Notes Page, 4. (b) Theme,
5. (b) Normal View.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. F5, 2. Slide Sorter, 3. Colourful, 4. Q, 5. Ink Annotation.

C. Write T for True and F for False statements :
1. T, 2. F, 3. T, 4. T, 5. F.
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D. Match the following figures to correct option :

E. Short Answer Type Questions :
1. The purpose of PowerPoint is to present the graphics information in

the form of a slide show.
2. A slide is a page which can be created to give information on a topic.
3. A presentation is made up of various slides which are arranged in a

systematic order.
4. Various themes provided by Office 2016 are, (i) Colourful (ii) Dark

Grey (iii) White.
5. Various presentation views are, Normal View, Outline View, Slide

Sorter View, Notes Pages View and Reading View.
F. Long Answer Type Questions :

1. To create a photo album, the steps are as follows :
(i) Go to Insert tab.

(ii) In Images group, click on drop-down arrow of Photo Album.
(iii) From the drop-down list, select New Photo Album option.
(iv) A Photo Album dialog box opens.
(v) In Insert Picture from section, click on File/Disk button.

(vi) An Insert New Picture dialog box will appear on the screen.
(vii) Browse and select as many pictures and click on Insert button.

(viii) The pictures will be added to Pictures in Album box in Photo
Album dialog box.

(ix) The picture can be viewed by you.
(x) You can see the Up and Down arrow below the Picture box. These

arrows are used to move the selected pictures up and down.
(xi) Click on Remove button to delete the selected picture.

(xii) Choose the Picture Layout and Frame shape for the album.
(xiii) Click on Create button.
(xiv) PowerPoint creates a Picture Album slide for you.

2. The purpose of Ink equation is to insert math equations in your slides
by writing them directly with the help of some pointing device. For
this, you can make use of mouse or stylus or some touch pad and write
the equation directly on screen or pad. PowerPoint will automatically
change your written equation into the text.
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3. To cre ate a photo al bum, the steps are as fol lows :
(i) Go to Insert tab.

(ii) In Im ages group, click on drop-down ar row of Photo Al bum.
(iii) From the drop-down list, select New Photo Album option.
(iv) A Photo Album dialog box opens.
(v) In Insert Picture from section, click on File/Disk button.

(vi) An Insert New Picture dialog box will appear on the screen.
(vii) Browse and select as many pictures and click on Insert button.

(viii) The pictures will be added to Pictures in Album box in Photo
Album dialog box.

(ix) The picture can be viewed by you.
(x) You can see the Up and Down arrow below the Picture box. These

arrows are used to move the selected pictures up and down.
(xi) Click on Remove button to delete the selected picture.

(xii) Choose the Picture Layout and Frame shape for the album.
(xiii) Click on Create button.
(xiv) PowerPoint creates a Picture Album slide for you.

4. Smart Lookup is a very important feature of PowerPoint 2016.
Using this feature, we can find the information regarding any word on 
the web using Microsoft’s Bing search engine. Using this feature, you 
do not need to open a web browser and type the keyword to search it
manually.

5. You can create a text in your own handwriting too. For this, the steps
are as follows :
(i) Go to Review tab.

(ii) In Ink group, select Start Inking option.
(iii) A new Pen tab is added to the ribbon and opened in front of you.
(iv) A new tab with the name Ink Tool comes on the screen with

various tools.
(v) By default, Pen tool is selected.

(vi) Select the colored Pen from the Pens group.
(vii) Select the color and thickness of the pen by clicking on the

drop-down arrow of Color and Thickness options.
(viii) Now write something on the blank area with the help of mouse or

stylus.
Highlighting Text : Just like we do on a sheet of paper, we can highlight
text in a presentation. For this, the steps are as follows :

(i) In Pens tab, select Highlighter tool under Write group.
(ii) Select the type of Highlighter from Pens group.

(iii) Now, click and drag the mouse to highlight the text.
6. Slides can be arranged as per the given steps :

(i) Click on View tab> Normal View to open the presentation in
Normal View.

(ii) In Slides Navigation pane, select the slide thumbnail and drag it to 
move to another location and drop it.

(iii) In this manner, you can rearrange all the slides.
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6. Formatting A Presentation

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) Top, 2. (b) Title, 3. (c) SmartArt, 4. (a) Table, 5. (a) Chart.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Body Text, 2. SmartArt, 3. Slide Master, 4. Images, 5. Themes.

C. Write T for True and F for False statements :
1. T, 2. T, 3. F, 4. F, 5. T.

D. Match the following figures to the correct options :

E. Short Answer Type Questions :
1. The top slide in Microsoft PowerPoint is called the Slide Master. This

Slide controls the theme, layout, color, background, fonts, etc.
2. SmartArt is a graphic tool which is used to visually communicate the

information.
3. The colour scheme of slide can be changed as per the given steps :

(i) Go to Design tab.
(ii) In Themes group, click on More drop-down arrow to  see more

Themes and select a particular theme by clicking on it.
(iii) Click on More drop-down arrow in Variants group.
(iv) Hover the mouse over Colors option.
(v) When you hover the mouse on various color schemes, it will

reflect on the slide. Choose the required color scheme and right
click on it. Choose Apply to All Slides option.

4. SmartArt is a graphic tool which is used to visually communicate the
information.

5. A chart is an effective way to display data in a graphical and pictorial
form. Charts make it easier to show comparisons and growth,
relationship among the values and trends in data. Charts provide an
accurate analysis of the information. Rather than giving the
information in the form of text, you can add chart in the slide to
represent the information.
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F. Long Answer Type Questions :
1. The Slide Master is the main slide that stores information, including

font styles, placeholder sizes, position of text and objects, bullet
styles, background design and colour schemes. Suppose you have
multiple slides in a presentation and you want all the slides contain
same font and styles, you can apply it at one place i.e., Slide Master
and that will be automatically applied to all other slides. Slide Master
always appear as the top slide in a Slide Navigation Pane and the
related slide layout appears just below this Slide Master. When you
apply some editing in a Slide Master, all the other slides that follow
the Slide Master will be reflected with those changes. When you
insert a Slide Master, it contains two placeholders :
(i) Slide Title placeholder : It has the title of the page.

(ii) Body Text placeholder : It has the text, objects, charts, tables,
pictures and other components.

2. To create a new custom layout, the steps are as follows :
(i) Go to View tab.

(ii) In Master Views group, select Slide Master option.
(iii) A Slide Master tab appears in the Ribbon.
(iv) Select this tab. In the Slide Master Navigation Pane, select the

Blank Layout.
(v) You will see some default placeholders in it like Date/Time or

Footer, etc. You can delete them if not required.
(vi) Now, add a placeholder by clicking on drop-down arrow of Insert

Placeholder command in Master Layout group and select the type
of placeholder from the list like Text, Picture, Chart, Table, etc.

(vii) Click and drag the mouse to insert a placeholder in a slide master.
(viii) From the Navigation Pane, right click on the selected layout. From 

the list, click on Rename Layout option.
(ix) A Rename Layout dialog box opens. Type the new name for the

layout. Click Rename button.
(x) Now save the file by clicking on File> Save As.

(xi) In Save As dialog box, type the name of the file. In Save as type,
select PowerPoint Template and click Save button.

(xii) Click on Close Master View button. You will see that the
customized layout has been added to the built-in-layout list.

3. To format the background colour of a slide, the steps are as follows :
(i) Go to Design tab.

(ii) In Customize group, select Format Background command.
(iii) A Format Background task pane opens.
(iv) In Fill section, select the desired option to fill the background by

clicking on the radio button.
(v) Click on Fill Color drop-down arrow and select the desired color.

(vi) You can set the transparency of the color by moving the slider of
Transparency option.
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(vii) Click on Apply to All button present at the bottom of the task pane
to apply the selected color to all the slides.

4. The steps to insert a SmartArt in a slide are as follows :
(i) Open a Blank Slide.

(ii) Go to Insert tab.
(iii) In Illustrations group, select SmartArt command.
(iv) A Choose a SmartArt Graphic dialog box opens.
(v) From the left side, select the category of SmartArt. (say Cycle)

(vi) The middle part displays the related options. Select the desired
option. (say Text Cycle)

(vii) The right part shows the preview of the selected SmartArt.
(viii) Click OK button.

(ix) A blank Text Cycle is displayed on the slide.
(x) Click on the Text, a cursor appears on the screen and type some

text in it.
(xi) Similarly, you can add any SmartArt which you feel better convey

your information to the audience while presenting the topic.

7. OneNote

 Let Us Answer 

A. Multiple Choice Questions :
1. (a) OneNote, 2. (b) 2015, 3. (b) Bulb, 4. (c) File.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Pen, 2. Template, 3. Ink to Text, 4. Share with meeting.

C. Write T for True and F for False statements :
1. T, 2. T, 3. T, 4. T, 5. T.

D. Match the following figures to the correct options :

E. Short Answer Type Questions :
1. Microsoft OneNote is a digital notebook that helps in making quick

notes either handwritten or typed.
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2. The steps to start OneNote are as follows :
(i) Go to Start.

(ii) Click on All apps.
(iii) Click on OneNote 2016 option.
(iv) A OneNote window appears on the screen.

3. Section is a particular part of a new page.
4. The steps to add a new section and rename it are as follows :

(i) Click on the Create a New Section (+) tab.
(ii) A new section appears with new tab.

(iii) The default name of the new tab is highlighted.
(iv) Type the new name for it and press Enter key from the keyboard.

F. Long Answer Type Questions :
1. Various features provided by OneNote 2016 are :

(i) Create Hand Written or Typed Notes : Using OneNote, you can 
make the notes by using a pen with touch screen or you can type
from the keyboard.

(ii) Insert Links : OneNote allows you to add links in it manually by
using the Insert>Link option. When you click on the link, it will
open the page whose URL is provided. You can link a picture,
page or other section of the Note.

(iii) Add File From Other Application : OneNote also provides the
facility to add other files and documents like Word document,
Excel spreadhseet or PowerPoint presentation, etc. in your notes.

(iv) Add Images : Office Lens is a plane app. It is an amazing built in
feature of OneNote to capture notes from white boards, menus,
drawings, sketches, images or anything with a lot of text.

(v) Add Tables : OneNote allows you to organize your data in tabular
form by adding tables in it.

2. Steps to create a new notebook are as follows :
(i) Click on File menu.

(ii) Click on New option from the list.
(iii) A New Notebook window appears.
(iv) Click on This PC option.
(v) Type the name of the Notebook in Notebook Name text box.

(vi) Click on the Create Notebook button placed below the textbox.
(vii) A new Notebook appears on the screen.

3. Steps to open an existing notebook are as follows :
(i) Click on File menu.

(ii) From the list, select Open op tion.
(iii) An Open Note book win dow ap pears.
(iv) An Open dialog box appears.
(v) Type the name of the file which you want to open. Or browse or

click on the file to open it.
(vi) You can also browse for a notebook that is saved on different

location by clicking on the Browse option.
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4. OneNote provides you with a bundle of pre-designed layouts called
Templates. These templates enhance the appearance of your
notebook. To add a template, the steps are as follows :
(i) Click on Insert tab.

(ii) In Pages group, click on the drop-down arrow of Page
Templates.

(iii) Select Page Templates option from the drop-down list.
(iv) A Templates task pane opens on the right side of the window.
(v) In Add a Page section, there are five categories of templates :

(a) Academic, (b) Blank, (c) Business, (d) Decorative, 
(e) Planners.

(vi) Click on the any category of template.
(vii) It will display various options of template.

(viii) Select any option by clicking on it and a new page opens with
selected template.

(ix) Click Close button to close the task pane.
5. OneNote allows you to create Quick Notes with or without opening

the OneNote app. As you write down your thoughts and ideas on
sticky notes, likeness, Quick Notes are perfect to capture your
thoughts on one device.
To create a quick note, the steps are as follows :
(i) Press Windows key + N. It will open a small Quick Note Window

in your OneNote notebook.
(ii) Type your notes in the window. Format the text using the mini

toolbar, if required.
(iii) To view the OneNote ribbon, click the three small dots displayed

on the top of the Quick Note Window.
(iv) Click on the Full Page View on the View tab to view the quick note 

in full screen mode.

8. MS Excel 2016

 Let Us Answer 

A. Multiple Choice Questions :
1. (b) Cell, 2. (a) left, 3. (a) Numbers, 4. (a) One, 5. (a) Chart.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. workbook, 2. Spreadsheet, 3. horizontally, 4. Ctrl + O, 5. Equal to (=).

C. Write T for True and F for False statements :
1. T, 2. T, 3. T, 4. T, 5. F.

D. Short Answer Type Questions :
1. MS Excel is a spreadsheet application which is used to organize and

analyze the data, store the data, perform functions and calculations on
the data.
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2. A cell is an intersection of row and column.
3. Each cell has an address which consists of column letter and row

number. For ex : A1 is a cell address which is in row number 1 and
column number A.

4. When you type some text or formula in a cell, it is displayed in the
Formula bar.

5. To create a new workbook, follow the given steps :
(i) Click on File menu.

(ii) From the menu list, click New option.
(iii) A New window opens.
(iv) Click on Blank Workbook.
(v) A new Workbook comes on the screen in front of you.

E. Long Answer Type Questions :
1. MS Excel consists of workbook, whereas a notebook consists of

worksheets. It is similar to your notebook which consists of pages. By
default, there are three worksheets in a workbook. User can add or
delete the worksheets as required. A worksheet is a single spreadsheet 
which consists of cells. Data is stored in cells. A worksheet starts with
row number 1 and column number A. It means the address of first cell
will be A1.

2. Various features of Excel are :
Conditional Formatting : It Conditional Formatting, you can apply
formatting on data when the values in cells meet certain conditions.
Sparklines : Sparklines are the tiny charts, which are so small that
they can fit within a worksheet cell.
Cell Styles : Excel provides more than 40 colourful readymade cell
styles. You can go to the cell gallery and apply any style to the
selected cell. You can preview the styles before apply them.
Editing and Formatting from Home Tab  : In Excel 2016, we can
edit and format data just by going to the home tab because all the
editing and formatting options are available there. User don’t have to
explore the menus and toolbars to find the right options.
No Chart Wizard : There is no wizard for creating charts. You can
select the data and go to Insert tab to select the type of chart and chart
will be created.

3. The steps to select cells, rows, columns and worksheet in Excel are as
follows :
(i) To select a cell, just move the mouse pointer on a cell and click it

once. A cell gets highlighted.
(ii) To select an entire row, click the row heading.

(iii) To select a entire column, click the column heading.
(iv) To select the entire worksheet, click on Select All button which

appears at the extreme left of row heading.
(v) To select adjacent row, select the row and press Shift key, hold it

and click on the last row.
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(vi) To select adjacent column, select the column and press Shift key,
hold it and click on the last column.

(vii) To select non-adjacent row, select the row and press Ctrl key, hold
it and click on the row which you want to select.

(viii) To select non-adjacent column, select the column and press Ctrl
key, hold it and click on the column which you want to select.

4. The kind of data that can be entered in a worksheet is as follows :
(i) En ter ing Num bers and Spe cial Char ac ters : Num bers are the

nu meric val ues which are made up of the dig its 1, 2, 3, 4, 5, 6, 7, 8,
9 and 0. Spe cial char ac ters are the pe riod (dec i mal point), a
comma be tween num bers, a mi nus sign or plus sign and a per cent
sign af ter the num ber. To en ter a num ber in a cell, just click on the
cell to make it ac tive and type the num ber from the key board.

(ii) Entering text : Text includes words, sentences, numeric values
and alpha-numeric values. For example : Name, Class, Roll No.,
etc. To enter a text in a cell, just click on the cell to make it active
and type the text from the keyboard.

(iii) Entering Formulas : Formulae are mathematical equations
involving number values, operators and cell addresses used for
performing calculations on a worksheet. Formulae can range from
basic mathematical operations to couples calculations. Each
Formulae must begin with equal to (A) sign.

(iv) Entering Date/Time : You can enter date in a cell in various
ways, like 1/1/2018 or 1-Jan-2018 or 1-Jan, or January, 2018.
When you type something like that in a cell, Microsoft Excel get to 
know that you are entering a date and automatically applies a date
format to that cell. Similarly, a time can be entered by using colons 
like 08:25:40. A date or time can be entered as static or dynamic.

5. We can use a formula to perform calculations or operations on the cell 
values like addition, subtraction, multiplication and division. These
operations can be performed by using operators like :
Each formula must begin with “=” (equal to) sign. It made up of
numbers, cell address, operators and parenthesis.
Types of Formulas :
Two types of formulas are as follows :
(a) Basic Formulas, (b) Compound Formulas.

6. (a) Re name a Worksheet : Re nam ing a Worksheet means to change
the name of the worksheet.

(i) Double click on the Sheet tab.
(ii) It will get highlighted and a cursor comes on the screen.

(iii) Type the new name for the worksheet.
(iv) Press Enter key from the keyboard.
(b) Adding a New Worksheet : (i) To add a new worksheet, select

the sheet before which you want to place a new worksheet.
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(ii) Right-click on the Sheet tab and select the Insert option. The
Insert dialog box appears with the worksheet option selected.
Click OK. You will notice a new worksheet gets inserted before
the selected worksheet. On, Click on the New Sheet icon (+)
present text to the Sheet tab.A new worksheet will be added or
Select the Insert < Insert Sheet option in the Cells group or the
Home tab.

(c) Deleting a Worksheet : (i) Open a worksheet which is to be deleted.
(ii) Go to Home tab.

(iii) In Cells group, click on the drop-down arrow of the Delete option.
(iv) Select Delete Sheet option.
(v) The current sheet will get deleted.

9. Internet And E-Mail

 Let Us Answer 

A. Multiple Choice Questions :
1. (c) Networks, 2. (a) Local, 3. (b) IP Address, 4. (b) Search Engine.

B. Fill in the blanks by choosing the correct word from the given
bracket :
1. Video Conferencing, 2. Surfing, 3. Hyperlink, 4. @, 5. 25MB.

C. Write T for True and F for False statements :
1. T, 2. F, 3. T, 4. F, 5. T.

D. Short Answer Type Questions :
1. Internet is network of networks. It is the network which is used to

connect millions of computers spread across the world. It is the largest 
computer network which makes the network publicly accessible and
allows them to share information and resources. People can
communicate with others through sending messages, voice messages
and video chatting.

2. An IP Address, or simply on “IP”, is a unique address that identifies a
device on the internet or a local network. It allows a system to be
recognized by other systems connected via Internet Protocol.

3. Hotspots are sites that provide wireless internet access over short
distances. It is a physical location where people can access the
internet using Wi-Fi technology or Wireless Local Area Network.

4. Browsing also known as Surfing is a term used to explore the World
Wide Web (WWW) by clicking on one link to another link.

5. A link, also called a Hyperlink is used to connect one page to another.
E. Long Answer Type Questions :

1. Internet is used in many areas. Some popular areas as :
(i) Communication, (ii) Commerce and Trade, (iii) Health,
(iv) Education, (v) Booking Tickets.
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2. An Internet connection is a service, provided by an Internet Service
Provider (ISP) in exchange for a fee. It creates an internet account for
the user and assigns a username and password to him. User can login
to the internet by typing his username and password to the computer
and use the internet services. Various companies which provide the
internet connection are : MTNL, BSNL, Connect, Airtel, Vodafone,
Reliance, etc.

3. The four types of Internet connections are :
(i) Dial-up Connection : Dial-up connection requires users to link

their phone line to a computer, in order to access the internet. One
end of the telephone line is inserted into the computer and the
other end to the phone jack. The computer is configured to dial a
specific number provided by ISP, you are able to use the internet
connection. When you are using the internet, you are not able to
attend the phone calls. It is an inexpensive method to connect to an 
internet. But there are various internet services available which
allows you to use the internet and attend phone calls at the same
time.

(ii) Broadband Connection : This connection uses wide bandwidth,
which provides high speed internet access through various
transmission mediums. So, using this type of connection you are
able to download audios, videos, images, etc. at fast speed.
Another advantage provided by this connection type is that you
are able to attend phone calls while using the internet. There is no
disruption in using phones when you are online.

(iii) Cable TV Connection : Another cost-effective method to get the
high-speed internet connection is through Cable TV. This type of
connection uses the Cable TV lines to get a reliable and fast
internet services. You can use the internet and watch your
favourite shows at the same time.

(iv) Satellite : Satellite Internet Connection is useful for those areas
where it is not possible to use broadband connection. In Satellite
Internet Connection, incoming and outgoing data is send to and
from the computer through Satellite. For this, a subscriber must
have a satellite dish antenna and transceiver to transmit and
receive the messages.

4. Email stands for Electronic Mail. This is the most popularly used
internet service to transfer the mails electronically. It is the way to
send text messages to the people around the world. In spite of text
messages, user can send documents, audio, video files, images, etc. in
the form of attachments to the mails. When user sends a mail, it drops
in the inbox of the receiver, and remains there until the receiver
himself removes it from the inbox. It is not required that the recipient
should be online for receiving the mails. He can check it any time
from the inbox.                                                                               
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